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การค้นหาความรู้โดยการวิเคราะหข้์อมลูด้วย R และ Weka  
Knowledge Discovery by Data Analysis with R and Weka 

สณีุ รกัษาเกียรติศกัด์ิ 

การค้นหาความรู้ 

 การคน้หาความรูใ้นสิง่ทีเ่ราอยากทราบหรอืเราอาจจะเรยีกว่ากระบวนการวจิยั สามารถด าเนินการ
ได ้2 แนวทางคอื forward และ backward  

Forward เริม่จากวตัถุประสงค/์ค าถามการวจิยั หรอืโจทยห์รอืปัญหาการวจิยันัน่เอง (Objective หรอื 
Problem definititions) จากนัน้กจ็ะเป็นวธิกีารด าเนินการ (ซึง่อาจจะตอ้งมกีระบวนการทบทวนวรรณกรรม – 
review literature หรอืไมต่อ้งมกีไ็ด ้ เพราะโจทยอ์าจจะเป็นปัญหาทีเ่กีย่วกบัการปฏบิตังิาน ซึง่กด็ าเนินการ
ไดเ้ลย) ในวธิกีารด าเนินงาน จะเกีย่วขอ้งกบัการออกแบบและ/หรอืการพฒันาเพื่อใหไ้ดค้ าตอบของโจทยท์ี่
ตอ้งการ ในกระบวนการนี้อาจจะตอ้งมกีารออกแบบเครือ่งมอืทีใ่ชใ้นการเกบ็รวบรวมขอ้มลูเพื่อตอบโจทย ์
เครือ่งมอือยา่งง่ายทีใ่ชก้นัคอืการออกแบบสอบถาม จากนัน้กเ็ป็นการก าหนดกลุ่มตวัอยา่งทีจ่ะตอบ
แบบสอบถาม (sample)  ซึง่ตามหลกัการแลว้กต็อ้งมกีารนิยามประชากรทีเ่ราสนใจจะศกึษา (population) 
ดว้ย และระบุว่ากลุ่มตวัอยา่งทีไ่ดม้าและเป็นตวัแทน (representative) ของประชากรนัน้ ไดม้าดว้ยวธิกีารสุ่ม
ตวัอยา่ง (sampling) แบบใด  เช่น การสุ่มอย่างงา่ย (random sampling) ซึง่คอืการสุ่มทีทุ่กหน่วยของ
ประชากรมโีอกาสไดร้บัการสุ่มเขา้มาดว้ยความน่าจะเป็นทีเ่ท่ากนั หรอืการสุ่มแบบแบ่งชัน้ (stratify 
sampling) ซึง่คอืการสุ่มทีใ่หไ้ดส้ดัส่วนของตวัแปรทีต่อ้งการแบ่งชัน้ตามตอ้งการ เป็นตน้ แต่การวเิคราะห์
ขอ้มลูเพื่อตอบโจทยใ์นการท างานมกัใชก้ลุ่มตวัอยา่งตามสะดวก (convenient sample) ตวัอยา่งเช่น ในการ
ปฏบิตังิานทุกอย่าง ตอ้งมกีารประเมนิผลการปฏบิตังิานของกจิกรรมใด กจิกรรมหนึ่ง กใ็ชก้ลุ่มตวัอยา่งของผู้
ทีเ่ขา้มารว่มกจิกรรม เป็นตวัแทนของประชากรทีต่อ้งการ   

ในการวเิคราะหข์อ้มลูนัน้เราศกึษาจากกลุ่มตวัอยา่ง (sample) ทีเ่รามขีอ้มลู โดยค านวณค่าสถติ ิ
(statistics) ต่าง ๆ จากกลุ่มตวัอยา่ง ทีเ่ราเรยีกว่าสถติพิรรณนา (descriptive statistics)  ท าใหเ้ราไดค้วามรู้
เกีย่วกบัลกัษณะของกลุ่มตวัอยา่งทีเ่ราศกึษา แต่เราจะขยายผลของการศกึษาจากกลุ่มตวัอยา่งนี้ไปอนุมาน 
(inference) เพื่อใหไ้ดค้วามรูเ้กีย่วกบัประชากร (parameters) ไดโ้ดยกระบวนการทดสอบสมมตุฐิานทางสถติ ิ
(statistical hypothesis testing)  ซึง่เป็นกระบวนการใชส้ถติอินุมาน/สถติอิา้งองิ (inferential statisitcs) ซึง่
ค านวณจากสถติพิรรณนา (descriptive statistics) ส าหรบัการทดสอบคุณลกัษณะของประชากร 
(parameters) ทีต่อ้งการ โดยใชห้ลกัการความน่าจะเป็น (probability distribution) ของการแจกแจง 
(distribution) ของสถติอิา้งองินัน้ เพื่อสรปุความจรงิเกีย่วกบัประชากร  
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สถติอินุมานม ี 2 แบบ คอื สถติพิาราเมตรกิ (parametric) และสถตินิอนพาราเมตรกิ (non 
parametric) สถติพิาราเมตรกิจะมขีอ้ตกลงเบือ้งตน้ (assumption) ขอ้มลู/ตวัแปร (variable) ตอ้งมกีารแจก
แจงความน่าจะเป็นแบบปกต ิ(normal distribution)  ซึง่โดยธรรมชาตแิลว้ ขอ้มลูทีเ่กดิโดยธรรมชาตจิะมกีาร
แจกแจงแบบปกต ิ  ถา้ขอ้มลูไม่มกีารแจกแจงแบบปกตคิวรจะตอ้งใชส้ถตินิอนพาราเมตรกิแทน  ในการ
ค านวณของสถตินิอนพาราเมตรกิจะไมใ่ชข้อ้มลูดบิของตวัแปรมาค านวณ แต่จะใชอ้นัดบั (rank) ของขอ้มลู
มาค านวณ ซึง่เป็นวธิกีารทีห่ยาบกว่า ดงันัน้หากสามารถจะใช้วธิกีารทางสถติ ิ (statistical methods) ที่
เรยีกว่าพาราเมตรกิได ้กค็วรท าในเบือ้งแรก หากไมส่ามารถท าได ้เช่น ขอ้มลูไม่มกีารแจกแจงแบบปกติ หรอื
ขอ้ตกลงเบือ้งตน้ของวธิกีารทางสถตินิัน้ไมเ่ป็นจรงิ กค็่อยไปใชว้ธิกีารแบบนอนพาราเมตรกิแทน  ขอ้
ไดเ้ปรยีบของวธิกีารพาราเมตรกิคอืใหก้ าลงัการทดสอบ (power) สงูกว่าวธิกีารนอนพาราเมตรกิ 

วธิกีารทาง backward ม ี2 กรณ ีคอื  

กรณทีี ่ 1: เราอาจจะไมไ่ดร้ะบุค าถามการวจิยัทีช่ดัเจนนกัหรอืเพยีงระบุวตัถุประสงคก์วา้ง ๆ ไว ้ แลว้เกบ็
ขอ้มลูต่าง ๆ ทีค่าดว่าจะเกี่ยวขอ้งกบัวตัถุประสงคข์องโจทย ์ เช่น วตัถปุระสงค ์ คือ ต้องการศึกษาการ
ฝึกงานของนิสิตเอกวิทยาการคอมพิวเตอร ์ (วิชา CP493 Internship) ซึง่เป็นวชิาบงัคบัของหลกัสตูร 
ขอ้มลูและเครือ่งมอืทีจ่ะใชใ้นการเกบ็รวบรวมขอ้มลูทีจ่ะตอบโจทยย์งัไม่ชดัเจน (ซึง่จะเป็นโจทยใ์หผู้อ้บรมได้
ฝึกปฏบิตัต่ิอไป) 

กรณทีี ่2: การคน้หาความรูจ้ากขอ้มลูทีอ่ยูใ่นฐานขอ้มลูการปฏบิตังิาน (Knowledge Discovery in Database 
หรอื KDD) การคน้หาความรูใ้นกรณีนี้จะใชว้ธิกีารทางสถติ ิ (statistical methods) หรอืวธิกีารทางการท า
เหมอืงขอ้มลู (data mining) ดว้ยวธิกีารทางการเรยีนรูข้องเครือ่ง (machine learning) กไ็ด ้ 

 การคน้หาความรูโ้ดยวธิกีารเรยีนรูข้องเครือ่งจะตัง้อยูบ่นสมมตฐิานว่าจะแบ่งขอ้มลูออกเป็น 2 ชุด 
ชุดหน่ึงคอืชุดในการสรา้งโมเดล (training set) ซึง่จะเป็นขอ้มลูส่วนใหญ่ และขอ้มลูอกีชุดหนึ่งเรยีกว่าชุด
ทดสอบโมเดล (test set) ขอ้มลูสองชุดน้ีตอ้งเป็นอสิระต่อกนั (independent) คอืตอ้งไมซ่ ้ากนั  

เมือ่ท าการ train แลว้ จะไดผ้ลลพัธเ์ป็นความรูห้รอืโมเดล ซึง่อาจจะอยูใ่นรปูสมการ หรอื กฏ เป็นตน้ โมเดล
ทีไ่ดจ้ะมคีวามน่าเชื่อถอืเพยีงใดตอ้งมกีารประเมนิโมเดล โดยจะใช้ test set (จะกล่าวในรายละเอยีดต่อไป) 

วตัถปุระสงคข์องการอบรม 

1. แสดงการใชเ้ครือ่งมอืออนไลน์ Google WORK (FORMS และ SHEETS) ในการเกบ็รวบรวมขอ้มลู 
2. แสดงการวเิคราะหข์อ้มลูอย่างงา่ยโดย Google ส าหรบัขอ้มลูทีจ่ดัเกบ็โดย FORMS และวเิคราะห์

ขอ้จ ากดัของการประมวลผลโดย Google จากโจทย ์“การฝึกงานของนิสิต” 
3. แสดงการน าขอ้มลูจาก Google WORK มาวเิคราะหข์อ้มลูทางสถติโิดยใชโ้ปรแกรม R โดยมกีารสรา้งตวั

แปรใหม ่ วเิคราะหส์ถติพิรรณา  สถติอินุมาน เช่น การเปรยีบเทยีบค่าเฉลีย่ 2 กลุ่มดว้ย t-test การ
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เปรยีบเทยีบค่าเฉลีย่มากกว่า 2 กลุ่มดว้ย One way ANOVA และการทดสอบความแตกต่างของความถี่
ของกลุ่มดว้ยไครส์แคว์ 

4. ใชข้อ้มลูของ Weka เป็นตวัอยา่งในสรา้งโมเดลโดยใชก้ารวเิคราะห์ Regression และ Logistic 
Regression โดยวเิคราะหด์ว้ยโปรแกรม R 

5. ใช ้ Weka ในการท า data mining โดยใชข้อ้มลูตวัอยา่งของ Weka และวเิคราะหโ์จทยป์ระเภท 
Prediction/Regression, Classification, Association, Clustering โดยใช ้Explorer Interface 

6. เปรยีบเทยีบการวเิคราะหโ์จทยป์ระเภท Classification ดว้ย data set หลายชุด และใชห้ลาย algorithm 
โดยใช ้Experimenter Interface 

การใช้โปรแกรม R ในการวิเคราะหข้์อมลูทางสถิติ 

สณีุ  รกัษาเกียรติศกัด์ิ 

การ Install โปรแกรม R และ Package RcmdR 

1. ไป download โปรแกรมที ่ R Project  http://www.r-project.org/  
เลอืก Download R แลว้เลอืก CRAN Mirrors เป็น Thailand 

2. เลอืก Download R for Windows  แลว้เลอืก base จะไดด้งัรปู  

 
3. เลอืก Download R 3.4.3 for Windows ให ้save Application ที ่download (R-3.4.3-win.exe) 

http://www.r-project.org/
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4. ท าการ run โปรแกรม (install)  เลอืกโฟลเดอรต์าม default  

 
5. Select Components  

ใหเ้อา 32-bit Files ออกส าหรบัเครือ่ง 64 bits 
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6. เลอืกตาม default และ Next จนระบบตดิตัง้เสรจ็ 

 

7. เมือ่ Install เรยีบรอ้ยแลว้จะปรากฏไอคอนของโปรแกรม R บน Desktop  
8. ให ้double click โปรแกรมเพื่อใชง้าน  

โดยตอ้ง Install package เพิม่ส าหรบัเมนูการวเิคราะหข์อ้มลูทางสถติ ิ 
โดยไปที ่Packages > Install package(s) 
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9. เลอืก CRAN mirror  
10. เลอืก Packages เป็น Rcmdr  

ระบบจะถาม 

  
ใหต้อบ Yes  
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ระบบจะท าการ download packages ต่าง ๆ มาเกบ็ไว ้ 

11. เลอืก Packages > Load Packages จะขึน้ดงัรปู 

 
12. ใหก้ด Yes แลว้กด OK คอืให ้Install จาก CRAN 

 
 

13. ช่วงนี้จะใชเ้วลาสกัพกั รอจน download เสรจ็ (ระบบจะ download ทุก packages ทีจ่ าเป็น) 
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14. เมือ่เรยีบรอ้ยจะขึน้หน้าต่าง R Commander  สามารถทดสอบโดยอ่านขอ้มลูจาก Excel ได ้โดยไป
ทีเ่มนู Data > Import data > from Excel 

 
 

15. เมือ่เลกิใชง้านใหปิ้ด R Commander และ RGui 
16. เมือ่ตอ้งการใชง้านใหม ่เมือ่เปิด RGui ขึน้มาตอ้ง Load Package  Rcmdr มาใชง้านเสมอ 

หมายเหตุ  เนื่องจากการตดิตัง้ตอ้งใช ้Internet ดงันัน้จงึไดเ้ตรยีมโปรแกรม R ที ่install เรยีบรอ้ยแลว้ใน 
Virtual Machine ส าหรบัภาคปฏบิตั ิ
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การใช้เคร่ืองมือออนไลน์ Google WORK (FORMS & SHEETS) ในการเกบ็รวบรวมข้อมลู 

Google SHEETS 

เครือ่งมอืในการเกบ็รวบรวมขอ้มลู ในแบบเดมิมกัจะใชแ้บบสอบถามทีเ่ป็นกระดาษ เช่น ดงัตวัอยา่ง 
แบบรายงานการฝึกงานของนิสิต ชัน้ปีท่ี 3 …. ดงัแสดงในไฟล ์Report_Internship จากนัน้น าขอ้มลูมา
คยีข์อ้มลูลงใน Excel หรอื Goggle SHEETS ไดด้งัแสดงในไฟลช์ื่อ Report_Internship  

Google FORMS 

 การเกบ็รวบรวมขอ้มลูออนไลน์ดว้ย Google FORMS ก าลงัเป็นทีน่ิยมอย่างมากเนื่องดว้ยการสรา้ง
ฟอรม์ (FORM) ท าไดง้่าย และสามารถจะเกบ็ขอ้มลูแบบออนไลน์ไดท้นัท ี ท าใหป้ระหยดัค่าใชจ้่าย และ 
Google FORM ยงัประมวลผลขอ้มลูอยา่งงา่ยใหใ้นระดบัตวัแปรเดยีว เช่น จ านวนและรอ้ยละ เป็นตน้ หาก
ผูว้จิยัตอ้งการวเิคราะหข์อ้มลูเพิม่เตมิดว้ยโปรแกรมส าเรจ็รปูทางสถติอิื่น ๆ เช่น โปรแกรม SPSS หรอื
โปรแกรม R กส็ามารถ download ขอ้มลูจาก Form_responses มาใน Excel แลว้ด าเนินการต่อตามตอ้งการ
ได ้ 

 จากโจทย ์ “การฝึกงานของนิสติ” ผูว้จิยัไดส้รา้งเครือ่งมอืในการเกบ็ขอ้มลูเพิม่เตมิจากการฝึกงาน
ของนิสติ โดยใช ้Google FORMS ดงัแสดงในไฟล ์Form และขอ้มลูจากการตอบแบบสอบถาม ดงัแสดงใน
ไฟล ์ Form_Responses โดย Google จะประมวลผลขอ้มลูอยา่งง่ายใหด้งัแสดงในไฟล ์
Summary_Responses  

การจดัเตรียมข้อมลูส าหรบัการวิเคราะห ์

ผูว้จิยัไดจ้ดัเตรยีมขอ้มลูส าหรบัการวเิคราะหโ์ดยน าตวัแปรทีส่นใจจากไฟล ์ Report_Internship 
และจากไฟล ์Form_Responses  โดยท าการ join ดว้ย ID ซึง่กค็อืหลกัการท า ETL นัน้เอง แต่เนื่องจาก
ขอ้มลูมจี านวนน้อยและผูว้จิยัรูจ้กัขอ้มลูด ี จงึท าดว้ยมอื โครงสรา้งขอ้มลูทีไ่ดด้งัแสดงในตารางที ่ 1  และ
ขอ้มลูดงัแสดงในไฟล ์DataAll 
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ตารางท่ี 1 โครงสร้างข้อมูลของ “การฝึกงานของนิสิต” 
ชื่อตวัแปร ค าอธบิายตวัแปร ค่าของตวัแปร 

(Domain) 
ระดบัการวดั 
(Measure) 

ID รหสันิสติ รหสั 4 หลกัสุดทา้ย - 
GENDER เพศ ชาย, หญงิ  
GPA เกรดเฉลีย่ 1.00-4.00  
ORG_SIZE ขนาดขององคก์รทีฝึ่กงาน ขนาดเลก็ (น้อยกว่า 15 คน) 

ขนาดกลาง (15 - 50 คน) 
ขนาดใหญ่ (มากกว่า 50 คน) 

 

PAY ค่าเบีย้เลีย้ง ไมไ่ดร้บัเบีย้เลีย้ง  
น้อยกว่า 100  
100 - 200  
201 - 300  
301 - 400  
มากกว่า 400 

 

DAYS จ านวนวนัทีท่ างาน 20 – 60  
HOURS จ านวนชัว่โมงทีท่ างาน 130 - 500  
CP121, …, 
CP444 

ความรูท้ีใ่ชใ้นวชิาทีเ่รยีนมา 1 – 5 (น้อย – มาก)  

WSK1, …, 
WSK6 

ความรูแ้ละทกัษะในการท างาน 4=ดมีาก, 3=ด,ี 2=ปานกลาง, 
1=น้อย, 0=น้อยมาก 

 

USK1, …, 
USK5 

อตัลกัษณ์นิสติของมหาวทิยาลยั 
“มทีกัษะการสื่อสาร” 

4=ดมีาก, 3=ด,ี 2=ปานกลาง, 
1=น้อย, 0=น้อยมาก 

 

Letter ใบรบัรองการฝึกงาน 0=ไมม่,ี 1=ม ี  
Stamp ใบประทบัตราบรษิทั 0=ไมม่,ี 1=ม ี  
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ระดบัการวดัของข้อมลู (Level of Measurement) 

 ขอ้มลูหรอืตวัแปรหรอืแอททรบิวิต ์ (Attribute) ทีจ่ะวเิคราะหเ์พื่อหาค่าสถติขิองขอ้มลูในเบือ้งตน้นัน้ 
เราตอ้งทราบว่าขอ้มลูของนัน้มรีะดบัการวดั (measure) เป็นอยา่งไร  

 ระดบัการวดัแบ่งเป็น 2 ระดบัใหญ่ ๆ คอื  

1. ขอ้มลูเชงิคุณลกัษณะหรอืขอ้มลูเชงิคุณภาพ (Qualitative data)  
แบ่งออกเป็น 2 ระดบัคอื 
 Nominal เป็นขอ้มลูเชงิกลุ่มหรอืนามบญัญตั ิเช่น เพศ หรอื Gender ม ี2 กลุ่ม/ค่า คอื 

Male และ Female หรอื ชาย และ หญงิ เป็นตน้ 
 Ordinal เป็นขอ้มลูเชงิกลุ่มแบบมอีนัดบั เช่น วุฒกิารศกึษา หรอื EDU ม ี3 กลุ่ม/ค่า คอื 

ต ่ากว่าปรญิญาตร ี ปรญิญาตร ีสงูกว่าปรญิญาตร ีเป็นต้น ซึง่การศกึษามอีนัดบัจากต ่า
ไปสงู (มปีรมิาณ หรอื magnitude แต่ไมม่ ีscale หรอืหน่วยวดั)  

2. ขอ้มลูเชงิปรมิาณ (Quantitative data)  คอืขอ้มลูทีม่คี่าต่อเนื่อง (จ านวนจรงิ แต่ในทาง
ปฏบิตัอิาจจะบนัทกึเป็นจ านวนเตม็) มหีน่วยวดั (scale) แบ่งเป็น 2 ระดบัคอื 
 Interval เป็นขอ้มลูแบบช่วง มหีน่วยวดั เช่น คะแนน เป็นขอ้มลูทีไ่มม่ศีูนยส์มับรูณ์ มกั

เป็นเครือ่งมอืวดัทางจติวทิยา (psychological measurement) เครือ่งมอืสอบถามความ
คดิเหน็ ขอ้สอบวดัต่าง ๆ  หรอืเครือ่งมอืวดั KPI ต่าง ๆ  

 Ratio เป็นขอ้มลูแบบอตัราส่วน มหีน่วยวดั และมกัเป็นเครือ่งมอืวดัทางกายภาพ 
(physical measurement) ทีเ่ป็นสากล มศีูนยส์มับูรณ์หรอืศูนยแ์ท ้ท าใหส้ามารถ
เปรยีบเทยีบค่าของขอ้มลูแบบอตัราส่วนได้ เช่น อาย ุ(ปี) น ้าหนกั (กก.) ส่วนสงู (ซม.)  
เป็นตน้ 

หมายเหตุ  ในการวเิคราะหข์อ้มลูทางสถติ ิสถติทิีเ่ลอืกใชจ้ะขึน้อยูก่บัลกัษณะของขอ้มลู 3 
ระดบัเท่านัน้ คอื Nominal, Ordinal, Scale (Interval/Ratio)  

Measure ในโปรแกรม SPSS, Excel, R, Weka เป็นดงันี้  

 nominal ordinal Scale (interval/ratio) 

SPSS nominal ordinal scale 

Excel text text number 

R character, factor character, factor numeric 

Weka nominal nominal numeric 

Workshop 1: จงใส่ระดบัการวดัของขอ้มลู (Measure: nominal, ordinal, scale) ลงในตารางที ่1 
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สถิติและพารามิเตอร ์ 

สถติ ิ(statistics) เป็นตวัเลขเป็นค่าทีค่ านวณไดจ้ากกลุ่มตวัอยา่ง เป็นคุณลกัษณะของกลุ่มตวัอยา่ง 
(sample)  

พารามเิตอร ์(parameter) เป็นคุณลกัษณะของประชากร (population) ซึง่เราไมท่ราบค่า 

สถติ ิเป็นตวัประมาณค่า (estimator) ของพารามเิตอร ์  

 

Workshop 2: จงเขยีนสญัลกัษณ์แทนสถติแิละพารามเิตอรต่์อไปนี้ และแสดงสตูรการค านวณของค่าสถติ ิ 
(ตวัอยา่งสญัลกัษณ์: x̅, SD, r, µ, เป็นตน้) 

 สถติ ิ(สญัลกัษณ์และสตูรการค านวณ) พารามเิตอร ์(สญัลกัษณ์) 

ค่าเฉลีย่หรอื Mean   

ค่าเบีย่งเบนมาตรฐาน หรอื 
Standard deviation 

  

ค่าสมัประสทิธิส์หสมัพนัธ ์
หรอื Correlation 

  

การหาค่าสถิติส าหรบัตวัแปรเดียว 

ตวัแปรเชงิคุณลกัษณะ:  ค่าความถี่ (จ านวนและรอ้ยละ) หรอื Frequency & percentage  

กราฟ: กราฟแท่ง (bar chart) หรอืกราฟพาย (pie chart) 

ตวัแปรเชงิปรมิาณ:  ค่ากลาง และค่าการกระจาย หรอืค่าเปอรเ์ซน็ไทลต่์าง ๆ ไดแ้ก่ 

   ค่าเฉลีย่ (Mean) และค่าเบีย่งเบนมาตรฐาน (Standard deviation)  

   ค่ามธัยฐาน (Median) และค่า Interquartile Range (Q3 – Q1) 

 ค่าเปอรเ์ซน็ไทล ์(Percentile) ต่าง ๆ เช่น P10, P25=Q1, P50=Q2=Median, P75, 
P90 เป็นตน้ 

กราฟ:  ฮสีโตรแกรม (histogram) แสดงการแจกแจง (distribution) ของขอ้มลู หรอื 
box plot (แสดงค่า Q1, Q2=Median, Q3)  
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Workshop 3: ใชโ้ปรแกรม R หาค่าสถติเิบือ้งตน้ของโจทย ์“การฝึกงานของนิสติ” ขอ้มลูอยูใ่นไฟล ์DataAll 
และสรา้งตวัแปรใหม่ 

1. เปิดโปรแกรม R โดยดบัเบลิคลกิ  บน desktop มาท างาน 

2.  เลอืก Packages > Load package (รปูซา้ย) แลว้เลอืก Rcmdr (รปูขวา)  

  
 จะได ้R Commander ซึง่เป็นเมนูทีผ่กูฟังกช์นัการท างานของโปรแกรมค านวณค่าสถติต่ิาง ๆ (เหมอืน
เมนูของ SPSS) ท าใหง้า่ยต่อการใชง้าน 
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3. อ่านขอ้มลู Excel ดว้ยค าสัง่ Data > Import data > from Excel, .. 

   
 

 ตัง้ชื่อ dataset เป็น DataAll แลว้กด OK 
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เลอืกไฟล ์DataAll.xlsx จาก CD (เลอืกไฟล ์type เป็น MS Excel 2007 file (.xlsx) แลว้เลอืก Sheet 
DataAll จะได ้

 
หน้าจอการท างานของโปรแกรม R จะแบ่งเป็น 3 ส่วนคอื 

 R Script เป็นค าสัง่ R จากเมนูทีเ่ลอืก 
 Output  แสดงผลลพัธก์ารประมวลผล  
 Messages  แสดงขอ้ความส าหรบัการท างานนัน้ (อ่านขอ้มลูเขา้ 996 rows 35 columns) 

ถา้เกดิ error ขอ้ความกจ็ะเป็นสแีดง 

 

หมายเหตุ: R Markdown เป็น feature ใหมใ่น 
version นี้ (ยงัไมไ่ดท้ดสอบการใชง้าน) ไม่
เกีย่วกบัการประมวลผลทางสถติ ิ

4. ดขูอ้มลูโดยกดปุ่ ม  
ถา้ไม่มขีอ้มลู (missing value) R จะแทนดว้ยอะไร?   …………  

5. Clear window (ท าเป็นครัง้คราวตามตอ้งการ) โดยคลกิขวาที ่window ทีต่อ้งการ clear เลอืก Clear 
window 
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6. หาคา่สถติเิบือ้งตน้ (descriptive statistics) ของแต่ละตวัแปรเพื่อสรปุลกัษณะของขอ้มลู 
Qualitative variables: GENDER, ORG_SIZE, PAY, Letter, Stamp  
ดว้ยการหาการแจงแจงความถี่ (จ านวนและรอ้ยละ) ดว้ยค าสัง่ Frequency distributions 
และแสดงกราฟวงกลม ดว้ยค าสัง่ Pie Chart 
Quantitative variables: GPA, DAYS, HOURS, CP121, , CP444, WSK1, , WSK6, USK1, USK6 
ดว้ยการหาค่ากลางและค่าการกระจาย ดว้ยค าสัง่ Numerical summaries 
 

ส าหรบั Qualitative variables: 

6.1 เลอืกค าสัง่ Statistics > Summaries > Frequency distributions จะได ้

 
 จะเหน็ไดว้่ามแีค่ 3 ตวัแปร ทีเ่ป็น factor (ใน R ตวัแปร character จะเป็น factor โดยอตัโนมตั)ิ ไม่

มตีวัแปร Letter และ Stamp เนื่องดว้ยค่าของตวัแปรเป็นตวัเลข (จาก Excel)  R เลยใหช้นิดเป็น 
numeric  

6.2 แปลงตวัแปร Letter, Stamp ใหเ้ป็น factor ดว้ยค าสัง่ Data > Manages variables in active data 
set > Convert numeric variables to factors 
 

 

Variables: เลอืก Letter  
Factor Levels: เลอืก Supply level names  
New variable name …..: เลอืก default 
คอื <same as variables> คอืชื่อเดมิ หรอื
จะตัง้ชื่อใหม ่ตัง้ใหมเ่ป็น Letter_F 

กด OK 
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ใส่ชื่อค่าของขอ้มลู (Numeric value Level 
name) ดงัภาพ แลว้กด OK 

 ลอง  ด ูจะได ้

 
ขอ้มลูของแต่ละคอลมัน์จะไมต่รงเน่ืองจากการแสดงผลภาษาไทย 

แปลงตวัแปร Stamp ใหเ้ป็น factor โดยใช ้Use Number ส าหรบั Factor Levels และแทนทีต่วัแปรเดมิ  
(<same as variables>) เพื่อความรวดเรว็ หรอืจะตัง้ชื่อตวัแปรใหมเ่ป็น Stamp_F  
หมายเหตุ ถา้เราตอ้งการใชต้วัแปรเดมิทีเ่ป็น numeric เราตอ้งสรา้งตวัแปรใหมใ่หเ้ป็น factor จะได้
มตีวัแปร 2 ตวั เลอืกใชไ้ดต้ามความเหมาะสม 

หมายเหตุ  ใน R ม ีdata type ไดห้ลายแบบ ไดแ้ก่ scalars, vectors (numerical, character, logical), 
matrices, data frames, and lists. ซึง่ data frame กค็อืชนิดขอ้มลูทีเ่ป็นตาราง (table หรอื relation) 
นัน่เอง คอืแต่ละคอลมัน์จะเป็นตวัแปร ซึง่จะมชีนิดเป็น numeric หรอื character (ซึง่กค็อื string) ถา้
ขอ้มลูเป็น character R จะถอืเป็นnominal อตัโนมตัแิลว้ให ้type เป็น factor ส่วนตวัแปรทีเ่ป็น 
numeric ถา้จะใหเ้ป็น factor กต็อ้งด าเนินการ ดงัตวัอยา่งขา้งตน้ 
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6.3 เลอืกค าสัง่ Statistics > Summaries > Frequency distributions ใหม ่เลอืกตวัแปรทัง้หมด (5 ตวั) 

 คลกิ OK 
จะได ้
R Scrip Output 
local({ 
  .Table <- with(DataAll, table(Stamp_F)) 
  cat("\ncounts:\n") 
  print(.Table) 
  cat("\npercentages:\n") 
  print(round(100*.Table/sum(.Table), 2)) 

counts: 
Stamp_F 
 0  1  
58 12  
 
percentages: 
Stamp_F 
    0     1  
82.86 17.14 

local({ 
  .Table <- with(DataAll, table(GENDER)) 
  cat("\ncounts:\n") 
  print(.Table) 
  cat("\npercentages:\n") 
  print(round(100*.Table/sum(.Table), 2)) 
}) 

counts: 
GENDER 
 ชาย หญงิ  
  40   32  
 
percentages: 
GENDER 
  ชาย  หญงิ  
55.56 44.44 

หมายเหตุ หากขอ้มลูมมีากกว่า 3 ค่า การแสดง value label ทีเ่ป็นภาษาไทยจะเรยีงตาม
ตวัอกัษร ถา้ขอ้มลูเป็น Ordinal จะสบัสน เพราะมนัจะไมเ่รยีงอนัดบัให ้หากตอ้งการใหเ้รยีง
อนัดบักค็วรใส่ 1_, 2_, 3_, … ไวข้า้งหน้า 
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6.4 แสดงกราฟพายดว้ยค าสัง่ Graphs > Pie Chart ของตวัแปร Letter_F  ตาม default ได ้ 

 
ใหร้ะวงัและสงัเกตว่าผลลพัธข์องกราฟจะแสดงอยู่ใน RGUI ดงันัน้ตอ้งยุบหน้าต่าง R Commnader ก่อน 

ลองเรยีก Pie Chart อกีครัง้  

 

 คลกิที ่  เพื่ออ่านเอกสารว่าจะมกีารปรบัแต่งอะไรไดบ้า้ง  
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ส าหรบั Quantitative variables: 

6.5 เลอืกค าสัง่ Statistics > Summaries > Numerical summaries แลว้เลอืกกลุ่มวชิา CP… 
ตาม default จะใหค้่า Statistics เป็น Mean, Standard Deviation, Quantiles: 0, .25, .5, .75, 1  

  
R Scrip:  

numSummary(DataAll[,c("CP111", "CP121", "CP201", "CP212", "CP241", "CP251", 
"CP316", "CP322", "CP323", "CP342", "CP352", "CP431", "CP444", "CP445",   "CP482")], 
statistics=c("mean", "sd", "IQR", "quantiles"), quantiles=c(0,.25,.5,.75,1)) 

Output: 
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7. สรา้งตวัแปรตวัใหม่เพื่อวดั “ระดบัความรูท้ีใ่ช”้ ตัง้ชื่อว่า CP_All โดยเป็นค่าเฉลีย่ของ CP ทัง้หมด  

เลอืกค าสัง่ Data > Manage variables in active data set > Compute new variable 

 

Expression to compute = 
(CP111+ CP121+ CP201+ CP212+ 
CP241+ CP251+ CP316+ CP322+ 
CP323+ CP342+ CP352+ CP431+ 
CP444+ CP445+ CP482)/15 

(ให ้double click ตวัแปรทีต่อ้งการ) 

ลอง View Data Set  เพื่อดคู่าตวัแปรตวัใหม ่ตอ้งมคี่าอยูร่ะหว่าง 1 – 5  

 

8. ลอง plot กราฟ ของตวัแปรเชงิปรมิาณ ดว้ย histogram และ box plot  

 ค าสัง่: Graphs > Histogram (รปูซา้ย 
หรอื   Graphs > Boxplot (รปูขวา) 

 
 

 และหากจะส าเนากราฟกค็ลกิขวาทีร่ปูแลว้เลอืก Copy as bitmap 
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9. หาค่าสถติเิบือ้งตน้ของ CP_All ค าสัง่ทีใ่ช ้……………………………………………………………... 
และใหผ้ลสรปุ  
Script & Output 

 
ถา้ใหค้วามหมายของ Rating scale 5 ระดบั เป็น  
1=น้อยทีสุ่ด, 2=น้อย, 3=ปานกลาง, 4=มาก, 5=มากทีสุ่ด กจ็ะไดเ้กณฑก์ารประเมนิ 2 แบบ คอื  
แบบท่ี 1: ใชค้่ากลางในการใหค้วามหมาย จะไดเ้กณฑด์งัรปูซ้าย ซึง่ช่วงของหวัทา้ยจะไมเ่ท่าช่วงตรง
กลาง 
แบบท่ี 2: ใชแ้บบช่วงเท่าในการใหค้วามหมาย คอื แบ่ง max – min ออกเป็น 5 ช่วงเท่า ๆ  กนั (ช่วงละ .8) 
จะไดเ้กณฑด์งัรปูขวา 

1.00 – 1.50 = น้อยทีสุ่ด 
1.51 – 2.50 = น้อย 
2.51 – 3.50 = ปานกลาง 
3.51 – 4.50 = มาก 
4.51 – 5.00 = มากทีสุ่ด 

1.00 – 1.80 = น้อยทีสุ่ด 
1.81 – 2.60 = น้อย 
2.61 – 3.40 = ปานกลาง 
3.41 – 4.20 = มาก 
4.21 – 5.00 = มากทีสุ่ด 

แบบฝึกหดั ลองสรา้งตวัใหม่ตวัใหม ่เพื่อวดั “ดา้นความรูแ้ละทกัษะการท างาน” WSK และ  
“ดา้นอตัลกัษณ์นิสติของมหาวทิยาลยั – มทีกัษะการสื่อสาร” USK ว่าอยูใ่นระดบัใด  

10. จดัเกบ็ผลลพัธก์ารท างานไวใ้ชใ้นโอกาสต่อไป 
ใน R Commander: File > Save R Workspace as  ตัง้ชื่อไฟลว์่า Training  

 

จะไดไ้ฟล ์type เป็น R Data Files  

 
หากตอ้งการกลบัมาใชง้านใหม่ 

 ใน R Commander  
Data > Load data set 
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การทดสอบสมมติุฐานทางสถิติ  

การทดสอบสมมตุฐิานทางสถติเิป็นกระบวนสรปุความจรงิเกีย่วกบัประชากร (population) โดยศกึษาจาก
กลุ่มตวัอยา่ง (sample) ทีเ่ป็นตวัแทนของประชากร สถติทิีใ่ชจ้ะเรยีกว่าสถติอินุมาน (inferential statistics)  

ขัน้ตอนการทดสอบสมมุติฐานทางสถิติ (Hypothesis Testing Template) 

1. สมมตุฐิานทีท่ดสอบ H0 และ H1 (คุณลกัษณะของประชากร ตอ้งเป็นพารามเิตอรเ์สมอ) 
H0: .......... 
H1: ..........  

2. ก าหนดระดบันยัส าคญัของการทดสอบ α = ....... (ปกตจิะเป็น .05 หรอื .01 หรอื .10) 
3. เลอืกสถติทิีเ่หมาะสมกบัสมมุตฐิานทีท่ดสอบในขอ้ 1  

สถตินิี้คอืสถติอินุมาน/สถติอิา้งองิ และตวัสถตินิี้มกีารแจกแจงความน่าจะเป็นแบบใด? 
Z  = .....(สตูร).....   มกีารแจกแจงแบบ Z (ปกตมิาตรฐาน) 
t  = .....(สตูร).....   มกีารแจกแจงแบบ t ที ่df = ....... 
X2  = .....(สตูร).....  มกีารแจกแจงแบบ X2 ที ่df = ....... 
F  = ......(สตูร).... มกีารแจกแจงแบบ F ที ่df1 = .... และ df2 = ......  

4. กฏการตดัสนิใจ  ปฏเิสธ H0 ถา้ p-value < α   
5. ค านวณค่าสถติจิากกลุ่มตวัอยา่ง (โปรแกรมส าเรจ็รปูจะให ้p-value ดว้ย)  

เช่น  t = ..........   p-value = ...........   
6. ตดัสนิใจ ตคีวามและใหค้วามหมาย  

ตดัสนิใจ: ปฏเิสธ H0 / ไมป่ฏเิสธ H0   
ตคีวามและใหค้วามหมาย ................. 

อธิบายเพ่ิมเติม 
2.  ระดบันยัส าคญัของการทดสอบ หรอื Type I error คอื ความน่าจะเป็นทีป่ฏเิสธ H0 แต่ H0 เป็นจรงิ  
 ความจริงเก่ียวกบัสมมติุฐานท่ีทดสอบ (Actual/Model) 
การตดัสินใจ 
(Predicted/Test)        

H0 เป็นจรงิ  
(Positive) 

H0 เป็นเทจ็  
(Negative) 

ไมป่ฏเิสธ H0  / H0 เป็นจรงิ 
(Positive) 

ตดัสนิใจถูก 
(True Positive: TP) 
Confidence Level (1 – α) 

ตดัสนิใจผดิ (Type II error = β)  
(False Negative: FN) 

ปฏเิสธ H0 / H0 เป็นเทจ็ 
(Negative) 

ตดัสนิใจผดิ (Type I error = α) 
(False Positive: FP)   

ตดัสนิใจถูก 
True Negative: TN) 
Power of the test (1 – β) 
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3.  การแจกแจงความน่าจะเป็นของสถติทิดสอบ และค่าวกิฤตทีร่ะดบั α = .05 

 
P(Z < -1.96 และ Z > 1.96) = 0.05  

P(t < -2.05 และ t > 2.05) = 0.05 

 
P (X2 > 5.99) = 0.05 

 
P (F > 3.13) = 0.05 

 
4.  กฎการตดัสนิใจ  

แบบเดมิ: หาค่าวกิฤต ิโดยเปิดตารางการแจกแจงของขอ้ 3 เช่น  
ส าหรบัการแจกแจงแบบ Z  ค่าวกิฤตคอื -1.96 และ 1.96 บรเิวณวกิฤตคอื Z < -1.96 และ Z > 1.96 
     ปฏเิสธ H0 ถา้ ค่าสถติใินขอ้ 3 ตกอยูใ่นบรเิวณวกิฤต ิ(บรเิวณปฏเิสธ) ซึง่มคีวามน่าจะเป็น = α 
แบบใหม:่ ใชค้่าพ ี(p-value) (คอืความน่าจะเป็นจากค่าสถติจินถงึหางของการแจกแจง) เช่น  
ถา้ Z = 2.00 p-value คอื P(Z >= 2.00) + P(Z <= 2.00) = 0.02275013 + 0.02275013 = 0.0455  

6. ถา้การตดัสนิใจเป็น ปฏเิสธ H0 เรยีกว่า การทดสอบมนีัยส าคญั (the test is significant)  
แสดงว่า H0 (ความรูเ้ดมิ) ไมจ่รงิ  H1 จรงิ (H1 คอืความรูใ้หมท่ีน่กัวจิยัคน้พบ)  
ดงันัน้เป้าหมายของการวจิยัคอื การปฏเิสธ H0  ซึง่กค็อืตอ้งการใหก้ารทดสอบมนียัส าคญั  
ซึง่ต่างจากการทดสอบขอ้ตกลงเบือ้งตน้ (assumption) เช่น การทดสอบ Normal distribution หรอืการ
ทดสอบการเท่ากนัของ Variance คอืไมต่อ้งการปฏเิสธ H0  
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Workshop 4: การแจกแจงความน่าจะเป็นแบบต่าง ๆ  การหาค่าวกิฤตทีร่ะดบันัยส าคญัต่าง ๆ และการหา

ค่าพ ี(p-value) 
1. Plot การแจกแจงความน่าจะเป็นของการแจกแจงปกตมิาตรฐาน N(0,1)  

Distributtion > Continuous distributions > Normal distribution > Plot normal distribution 

 
 

2.  หาค่าวกิฤต (ค่าสถติ)ิ ทีร่ะดบันยัส าคญัต่าง ๆ (α)  
Distributtion > Continuous distributions > Normal distribution >  Normal quantiles  

 
Probabilities คอืค่า α (one tail)  
ผลลพัธท์ีไ่ดค้อืค่าวกิฤต (ค่าสถติ)ิ 
Script & Output 

 
 หากตอ้งการค่าวกิฤตของ α 2 tails ตอ้งหาร 2  คอืตอ้งใส่ Probabilites = .025  จะได ้ -1.959964 

หรอื -1.96  
 ลองด าเนินการดว้ยค่า α อื่น ๆ     
สรปุ  P(Z < -1.96 and Z > 1.96) = 0.05 

  P(Z < -1.64 and Z > 1.64) = 0.10 
  P(Z < -2.58 and Z > 2.58) = 0.01 
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3. หาค่าพ ี(p-value) จากค่าสถติทิีค่ านวณได ้ 
Distributtion > Continuous distributions > Normal distribution > Normal probabilities 

 
ผลลพัธท์ีไ่ดค้อืค่าพ ี(p-value) ของค่าสถิติทีใ่ส่ใน Variable value(s)  

Script & Output 

 
 
 ดงันัน้ p-value ของ 3.00 one tail คอื 0.001349898 ถา้ตอ้งการ 2 tails ตอ้งคณู 2 จะได ้0.002699796  
  
สามารถลองเล่นกบั distribution อื่น ๆ เช่น t distribution, Chi-squared distribution, F distribution 

การแจกแจงแบบปกติ 

โดยธรรมชาตแิลว้ขอ้มลูเชงิปรมิาณส่วนใหญ่จะมกีารแจกแจงแบบปกต ิ (Normal distribution) เช่น 
X1, X2, X3, …. เป็นค่าของขอ้มลูของกลุ่มตวัอยา่งทีม่าสุ่มมาจากประชากรทีม่กีารแจกแจงปกต ิ เขยีน
สญัลกัษณ์  Xi ~ N (µ, 2

)  และ ค่าเฉลีย่ของ X คอื x̅ ซึง่จะมกีารแจกแจงแบบ N (µ, 2
/N)   

การแจกแจงแบบปกตเิป็นขอ้ตกลงเบือ้งตน้ของสถติพิาราเมตริก (parametric statistics) หาก
ขอ้มลูไม่มกีารแจกแจงแบบปกตกิต็อ้งไปใชส้ถติแิบบนอนพาราเมตริก (nonparametric statistics)  

การท า transformation ของขอ้มลูอาจจะมคีวามจ าเป็นในบางกรณใีนกระบวนการวเิคราะหข์อ้มลู
ดว้ย data mining ทีส่ าคญั 2 อยา่งคอื การท าใหเ้ป็นปกตมิาตรฐาน (standardization) และการ 
normalization เพื่อใหค้่าของตวัแปรอยูใ่นมาตรวดัเดยีวกนั    

การท าใหเ้ป็นปกตมิาตรฐานคอืการลบดว้ยค่าเฉลีย่และหารดว้ยค่าเบีย่งเบนมาตรฐาน  ค่าปกติ
มาตรฐานจะมคี่าเฉลีย่เป็น 0 และค่าเบีย่งเบนมาตรฐานเป็น 1 ซึง่หลกัการน้ีเป็นหลกัการทีส่ าคญัในสถติิ
อนุมาน   
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การ normalization คอืการทีท่ าใหข้อ้มลูมคี่าอยูร่ะหว่าง 0 และ 1  ท าไดโ้ดยลบขอ้มลูดว้ย min และ
หารดว้ย max – min  

 

Workshop 5 จงทดสอบว่า CP_All มกีารแจกแจงปกตหิรอืไม่  

Statistics > Summaries > Shapio-Wilk test for normality เลอืก Variable > CP_All 
Script & Output 

 
 

การทดสอบสมมติุฐานทางสถิติ 
1. สมมตุฐิานทีท่ดสอบ H0 และ H1  

H0: CP_All มกีารแจกแจงแบบปกต ิ
H1: CP_All ไมม่กีารแจกแจงแบบปกต ิ 

2. ก าหนดระดบันยัส าคญัของการทดสอบ α = 0.05 
3. สถติทิดสอบ  

Shapiro-Wilk test for normality  
4. กฏการตดัสนิใจ  ปฏเิสธ H0 ถา้ p-value < α   
5. ค านวณค่าสถติจิากกลุ่มตวัอยา่ง   

ค่าสถติ ิW = 0.9796   p-value =  0.292  
6. ตดัสนิใจ ตคีวามและใหค้วามหมาย  

ไมป่ฏเิสธ H0   
CP_All มกีารแจกแจงปกต ิ
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ทดสอบค่าเฉล่ียของประชากร 1 กลุ่ม  

 การหา 95% ช่วงความเชื่อมัน่ของ µ = x̅ ± t0.025*SD/sqrt(N)  

Workshop 6: จงหา 95% ช่วงความเชื่อมัน่ของค่าเฉลีย่ของ CP_All  (1 sample t-test) 

ค าสัง่: Statistics > Mean > Single-Sample t-test  ใส่ค่า Null hypothesis mu = 2.549074 

 
Script & Output 

 
95% ช่วงความเชื่อมัน่ของค่าเฉลีย่ของ CP_All   

จงทดสอบให้เหน็จริง โดยการแทนค่าในสตูร 2.549074 ± 1.993943*(0.8238611/sqrt(72))  
                                                       = 2.549074 ± 0.193598  
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ทดสอบความแตกต่างของค่าเฉล่ียของประชากร 2 กลุ่ม  

Workshop 7:  นิสติหญงิและนิสติชายประเมนิการใชค้วามรูท้ีเ่รยีนในชัน้เรยีนกบัการท างาน (CP_All) 
แตกต่างกนัหรอืไม่  
หมายเหตุ 1. ตวัแปรทีเ่ราตอ้งการจะศกึษา/ตอ้งการทีจ่ะทดสอบ (CP_All) เรยีกว่าตวัแปรตาม (Dependent 
variable) ตวัแปรกลุ่ม (GENDER) เรยีกว่าตวัแปรตน้ (Independent variable) หรอืตวัแปรกลุ่ม (Group 
variable) 

หมายเหตุ 2. ใน Data warehouse Measure attribute กค็อื Dependent variable และ Dimension 
attribute กค็อื Independent variable หรอื Group variable นัน่เอง 

1. หาค่าสถติพิรรณนา Mean, SD, N ของ CP_ALL ของกลุ่ม ชาย และ หญงิ 

ค าสัง่: Statistics > Summaries > Numerical Summaries (ซา้ย)  คลกิ Summarize by groups (ขวา) 

 

 
เลอืก GENDER 

Script & Output 

 
ใหส้งัเกตว่า ผลลพัธข์า้งตน้ กค็อื เมเชอร ์8 ตวั (mean, sd, IQR, 0%, 25%, 50%, 75%, 100%, data:n) 
ซึง่ data:n aggregation function คอื count นัน่เอง ส่วนเมเชอรต์วัอื่น ๆ กค็อื CM (Calculated Member)  

2. ทดสอบค่าเฉลีย่ 2 ค่า 

ค าถาม แบบที ่1: Mean ของ CP_All ของชาย (2.660000) และของหญงิ (2.410417) แตกต่างกนัอยา่งมี
นยัส าคญัหรอืไม่?  

ค าถาม แบบที ่2: Mean ของ CP_All ของชาย และของหญงิ แตกต่างกนัหรอืไม่? 

ในแบบที ่1 Mean คอื Sample Mean (x̅ชาย และ x̅หญงิ)  
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ในแบบที ่2 Mean คอื Population Mean (µชาย และ µหญงิ)  

คน้หาค าตอบดว้ยการทดสอบ Independent samples t-test  
ค าสัง่: Statistics > Means > Independent samples t-test  

  
ซึง่ Independent samples t-test ม ี2 สตูร คอื สตูร Variances เท่า และ ไมเ่ท่า   
ดงันัน้จงึตอ้งทดสอบ Variances ก่อน 

3. ทดสอบ Variance 2 ค่า 

ค าสัง่: Statistics > Variances > Lavene’s test  

 

มสีถติใิหเ้ลอืก 3 ตวั คอื 
1. Two-variances F-test 
2. Bartlett’s test 
3. Levene’s test 

1 และ 2 มสีตูรค านวณปรากฏในต าราสถติิ
พืน้ฐานทัว่ไป 
3. SPSS ใชต้วันี้ 
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Script & Output 

 
ทดสอบสมมุติฐานในใจ:  p=value = 0.1332 แสดงว่าไมป่ฏเิสธ H0, H0 คอื Variances เท่า 

ดงันัน้ สรุปไดว้่า Variance เท่า  

4. ทดสอบค่าเฉลีย่ 2 ค่า โดยใช ้Independent samples t-test สตูร Variance เท่า  
ค าสัง่: Statistics > Means > Independent samples t-test (ใน Options: Assume equal variances? = Yes) 

  
Script & Output 
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การทดสอบสมมติุฐานทางสถิติ 
1. สมมตุฐิานทีท่ดสอบ H0 และ H1  

H0: µชาย = µหญงิ หรอื µชาย - µหญงิ = 0  เมือ่ µ คอืค่าเฉลีย่ของ CP_All 
H1: µชาย ≠ µหญงิ หรอื µชาย - µหญงิ ≠ 0  

2. ก าหนดระดบันยัส าคญัของการทดสอบ α = 0.05 
3. สถติทิดสอบ  

Independent samples t-test   

t = 
(𝑥̅1−𝑥̅2)

√(𝑛1−1)𝑠12+(𝑛2−1)𝑠22 

𝑛1+𝑛2−2
(

1

𝑛1
+

1

𝑛2
)

  มกีารแจกแจงแบบ t ที ่df = 40+32 -2 = 70 เมือ่ H0 เป็นจรงิ 

4. กฏการตดัสนิใจ  ปฏเิสธ H0 ถา้ p-value < α   
5. ค านวณค่าสถติจิากกลุ่มตวัอยา่ง   

ค่าสถติ ิt = 1.2831   p-value =  0.2037  
6. ตดัสนิใจ ตคีวามและใหค้วามหมาย  

ไมป่ฏเิสธ H0   
ค าตอบแบบที ่1: Mean ของ CP_All ของชาย และของหญงิ แตกต่างกนัอยา่งไมม่นียัส าคญั 
ค าตอบแบบที ่2: Mean ของ CP_All ของชาย และของหญงิ ไมแ่ตกต่างกนั 
 

หมายเหตุ  Independent samples t-test เป็นสถติพิาราเมตรกิ ซึง่มขีอ้ตกลงเบือ้งตน้ว่าขอ้มลูของ
ประชากร 2 กลุ่มตอ้งมกีารแจกแจงปกต ิหากขอ้ตกลงเบือ้งตน้น้ีไมเ่ป็นจรงิ ตอ้งไปใชส้ถตินิอนพาราเมตรกิ
ทีคู่่กนั ดว้ยค าสัง่ Statistics > Nonparametric tests > Two-sample Wilcoxon test   
การด าเนินการและการแปลผลใชห้ลกัการเหมอืนกนั 
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ทดสอบความแตกต่างของค่าเฉล่ียของประชากร 3 กลุ่ม  

Workshop 8: นิสติ 3 กลุ่ม ทีม่ ีGPA 3 ระดบัคอื ต ่า (< 2.50)  ปานกลาง (2.50 – 2.99) สงู (>= 3.00) ประเมนิ
การใชค้วามรูท้ีเ่รยีนในชัน้เรยีนกบัการท างาน (CP_All) แตกต่างกนัหรอืไม ่(One Way ANOVA)  

1. สรา้งตวัแปรตวัใหม ่(transformation) ชื่อ GPA_GP โดยแปลงค่า GPA ทีม่คี่าต่อเนื่องใหม้คี่าเป็น 3 กลุ่ม 
(discretization) ตามโจทย ์

ค าสัง่: Data > Manages variables in active data set > Recode variables  

 
หมายเหตุ  หากไมท่ราบว่าจะ Enter recode directives อยา่งไร ใหก้ดปุ่ ม Help   

Script 
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Output (View data set) 

     
2. ตรวจสอบผลการ Discritization 

ค าสัง่: Statistics > Summaries > Frequency distributions  

     
 

3. หาค่าสถติพิรรณนา Mean, SD, N ของ CP_ALL ของ 3 กลุ่ม (GPA_GP) 

ค าสัง่: Statistics > Summaries > Numerical Summaries Variables: เลอืก CP_All,  
Summarize by groups: เลอืก GPA_GP, Statistics เลอืก Mean, Standard Deviation  
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Script & Output 

 
4. One Way ANOVA มขีอ้ตกลงเบือ้งตน้ว่า Variance ของ 3 กลุ่มตอ้งเท่ากนั ถ้าไมเ่ท่าตอ้งไปใช้ 
Nonparametric ทีคู่่กนั  
ผลการทดสอบ Variance เท่า  ดงันัน้จงึใช้ One Way ANOVA ได ้(ลองทดสอบ) 

ค าสัง่:  Statistics > Means > One-way ANOVA   (เลอืก Pairwise comparisons of means) 

 
 

Script & Output 
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การทดสอบสมมติฐานทางสถิติ 

1. สมมตุฐิานทีท่ดสอบ H0 และ H1  
H0: µ1 = µ2 = µ3  เมือ่ µi คอืค่าเฉลีย่ของ CP_All ของ GPA_GP แต่ละกลุ่ม (ต ่า, กลาง, สงู) 
H1: ม ีµi ≠ µj  อยา่งน้อย 1 คู่  (มกีีคู่่?) 

2. ก าหนดระดบันยัส าคญัของการทดสอบ α = 0.05   
3. สถติทิดสอบ  

One way ANOVA (ANalysis Of Variances) 

F  = 
𝑀𝑆𝑏

𝑀𝑆𝑤
  = 

𝑆𝑆𝑏/ (𝑘−1)

𝑆𝑆𝑤/(𝑁−𝑘)
 ; มกีารแจกแจงแบบ F ที ่df = 3-1=2 และ df = 72-3 =69  (~F2,69) 

เมือ่ H0 เป็นจรงิ 
4. กฏการตดัสนิใจ  ปฏเิสธ H0 ถา้ p-value < α   
5. ค านวณค่าสถติจิากกลุ่มตวัอยา่ง   

ค่าสถติ ิF = 0.967   p-value =  0.385  
6. ตดัสนิใจ ตคีวามและใหค้วามหมาย  

ไมป่ฏเิสธ H0   
ค่าเฉลีย่ของ CP_All ของนิสติ 3 กลุ่ม (GPA_GP) ไมแ่ตกต่างกนั  
ซึง่สอดคลอ้งกยัการเปรยีบเทยีบรายคู่ (Miltiple Cpmparisons of Means) ดว้ยวธิ ีTukey  
ไมม่คีู่ใดทีแ่ตกต่างกนั ดงันัน้ค่าเฉลีย่ของทุกกลุ่มจะอยูใ่น set เดยีวกนั (สญัลกัษณ์ “a”) 

หมายเหตุ  One-way ANOVA เป็นสถติพิาราเมตรกิ ซึง่มขีอ้ตกลงเบือ้งตน้ว่าขอ้มลูของประชากรทุกกลุ่ม
ตอ้งมกีารแจกแจงปกต ิและความแปรปรวนของประชากรทุกกลุ่มตอ้งเท่ากนั หากขอ้ตกลงเบือ้งตน้นี้ไม่
เป็นจรงิ ตอ้งไปใชส้ถตินิอนพาราเมตรกิทีคู่่กนั ดว้ยค าสัง่ Statistics > Nonparametric tests > Kruskal-
Wallis test  การด าเนินการและการแปลผลใชห้ลกัการเหมอืนกนั 
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ทดสอบความเป็นอิสระของตวัแปรเชิงคณุลกัษณะ  

Workshop 9:  การออกใบรบัรองการฝึกงาน (Letter) เป็นอสิระหรอืสมัพนัธก์บัขนาดขององคก์รทีฝึ่กงาน 
(ORG_SIZE)  (Chi-square test for independent)  

1. หาค่าสถติพิรรณนา จะไดเ้ป็นตารางแจกแจงความถี่ 2 ทาง (Cross tab หรอื Table) 

ค าสัง่: Statistics > Contingency tables > Two-way tables  

  
Script & Output 
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หมายเหตุ  ใหส้งัเกต ใน WARNING: ส าหรบัการทดสอบไค-สแคว ์ค่าความถีค่วรตอ้งมจี านวน > 5  

การทดสอบสมมติฐานทางสถิติ 
1. สมมตุฐิานทีท่ดสอบ H0 และ H1  

H0: Letter และ ORG_SIZE เป็นอสิระต่อกนั (คอืไมม่คีวามสมัพนัธก์นั) 
H1: Letter และ ORG_SIZE ไมเ่ป็นอสิระต่อกนั (คอืมคีวามสมัพนัธก์นั) 

2. ก าหนดระดบันยัส าคญัของการทดสอบ α = 0.05 
3. สถติทิดสอบ: Chi-square test for independence   

χ²  =  ∑
(𝑂𝑖−𝐸𝑖)2

𝐸𝑖

𝑘
𝑖=1  ;  𝐸𝑖 = 𝑛𝑝𝑖  มีการแจกแจงแบบ χ²   ท่ี df = 2  เม่ือ H0 เป็นจริง 

4. กฏการตดัสนิใจ  ปฏเิสธ H0 ถา้ p-value < α   
5. ค านวณค่าสถติจิากกลุ่มตวัอยา่ง   

ค่าสถติ ิX-squared = 6.9529   p-value =  0.03092 
6. ตดัสนิใจ ตคีวามและใหค้วามหมาย  

ปฏเิสธ H0   
การออกใบรบัรองการฝึกงาน (Letter) ไมเ่ป็นอสิระหรอืมสีมัพนัธก์บัขนาดขององคก์รทีฝึ่กงาน 
(ORG_SIZE)   

2.  Save active data set ไวใ้ชง้านต่อไป 
ค าสัง่: Data > Active data set > Save active data set 
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ทดสอบความสมัพนัธข์องตวัแปรเชิงปริมาณ 

 ความรูแ้ละทกัษะในการปฏบิตังิาน (WSK), อตัลกัษณ์นิสติ “ทกัษะการสื่อสาร” (USK), GPA มี
ความสมัพนัธก์นัหรอืไม ่(Correlation)  

 Pearson correlation ส าหรบัขอ้มลูทีม่กีารแจกแจงปกต ิ

 Spearman rank correlation ส าหรบัขอ้มลูทีไ่มม่กีารแจกแจงปกต ิ

Workshop 10:  

1. Load data set Training2 มาใชง้าน (มตีวัแปร WSK และ USK แลว้) 
2. ทดสอบว่า WSK, USK, GPA มกีารแจกแจงปกตหิรอืไม่ 

ผลการทดสอบ: WSK, USK ไมม่กีารแจกแจงปกต,ิ GPA มกีารแจกแจงปกต ิ
3. หาความสมัพนัธ ์

ค าสัง่: Statistics > Summaries > Correlation test 

 
Script & Output 
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สรปุ: ตวัแปรทีส่มัพนัธก์นัมเีพยีงคู่เดยีวคอื WSK และ USK  
สมัประสทิธส์หสมัพนัธ ์(Correlation coefficient) = 0.7722563 

เมือ่ทดสอบสมมตุฐิานทางสถติจิะสรปุไดว้่า ความสมัพนัธไ์มเ่ป็นศูนย ์ 

4. ทดสอบว่าค่าเฉลีย่ WSK กบั USK แตกต่างกนัหรอืไม ่(Paired t-test) 

ค าสัง่: Statistics > Means > Paired t-test 
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Script & Output 

 
สรปุ ทกัษะไมแ่ตกต่างกนั 

 

หมายเหตุ  Paired t-test เป็นสถติพิาราเมตรกิ ซึง่มขีอ้ตกลงเบือ้งตน้ว่าผลต่างของขอ้มลู (paired) ของ
ประชากร ตอ้งมกีารแจกแจงปกต ิหากขอ้ตกลงเบือ้งตน้น้ีไมเ่ป็นจรงิ ตอ้งไปใชส้ถตินิอนพาราเมตรกิทีคู่่กนั 
ดว้ยค าสัง่ Statistics > Nonparametric tests > Paired-samples Wilcoxon test   
การด าเนินการและการแปลผลใชห้ลกัการเหมอืนกนั 
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การพยากรณ์หรือการวิเคราะหก์ารถดถอย (Regression)  

 การวเิคราะหก์ารถดถอยเป็นการพยากรณ์ตวัแปรทีส่นใจ (ตวัแปรตาม/dependent variable 1 ตวั) 
หรอืเป็นการอธบิายความแปรปรวนของตวัแปรทีส่นใจ ดว้ยตวัพยากรณ์หรอืตวัอธบิาย 
(predictor/explainatory/independent variables หลายตวั) โดยทีต่วัแปรตน้และตวัแปรตามตอ้งมี
ความสมัพนัธก์นัแบบเชงิเสน้อยา่งมนีัยส าคญั  ตวัแปรทัง้หมดตอ้งมรีะดบัการวดัเป็น scale หากเป็นตวัแปร 
nominal ตอ้งม ี 2 ค่าเท่านัน้ หากมมีากกว่า 2 ค่าตอ้งมกีารท าเป็น dummy variables วธิกีารนี้เรยีกว่า 
Multuple Linear Regression และมขีอ้ตกลงเบือ้งตน้ว่าตวัแปรตามทีร่ะดบัต่าง ๆ ของตวัแปรตน้ตอ้งมกีาร
แจกแจงแบบปกต ิ และมคีวามแปรปรวนเท่ากนั  หากตรวจสอบขอ้ตกลงเบือ้งตน้น้ีไมเ่ป็นจรงิอาจจะตอ้งท า
การ Transformation ขอ้มลู 

 หากตวัแปรตามเป็น nominal จะตอ้งใชว้ธิ ีLogistic Regression  

Workshop 11: หา Linear Regression Model ของ CPU data set (จาก Weka data set)   

1.  อ่านไฟล ์cpu.xls เขา้มาดว้ยค าสัง่ …………. 

2.  View data set จะได ้

 

โจทย ์สรา้งโมเดลหรอืสมการพยากรณ์ 
ประสทิธภิาพของการประมวลผลของ CPU 
ดว้ยคุณลกัษณะของคอมพวิเตอร ์ 

Depdendent variable คอื class 
(ประสทิธภิาพ) 

Predictor variables: MYCT, MMIN, 
MMAX,CACH, CHMIN, CHMAX ทัง้หมด 6 
ตวั 

มขีอ้มลูทัง้หมด  209 รายการ 

ตวัแปรทัง้หมดเป็น scale 

ค าถาม: ตวัแปรทุกตวัมกีารแจกแจงแบบปกติ
หรอืไม่? 

ตวั predictor แต่ละตวัมคีวามสมัพนัธเ์ชงิเสน้
กบัตวัแปร class หรอืไม?่ 

3.   ทดสอบการแจกแจงปกต ิสมมตวิ่าทุกตวัมกีารแจกแจงแบบปกติ 
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4. ทดสอบว่าตวัแปร class มคีวามสมัพนัธก์บัตวั predictor แต่ละตวัแบบเชงิเสน้ 
ค าสัง่: Graphs > Scratterplot 

 
Script & Output 
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5. สมมตติวัแปร predictor ทุกตวัมคีวามสมัพนัธแ์บบเชงิเสน้กบั class  
หาความสมัพนัธร์ะหว่าง predictors แต่ละตวักบั class 
Predictor r t, df p-value 
CASH 0.6626414 12.7297, 207 < 2.2e-16 
CHMAX 0.6052093 10.9381, 207 < 2.2e-16 
CHMIN 0.6089033 11.044, 207 < 2.2e-16 
MMAX 0.8630041 24.5775, 207 < 2.2e-16 
MMIN 0.7949313 18.8513, 207 < 2.2e-16 
MYCT -0.3070994 -4.6427, 207 = 6.102e-06 

หมายเหตุ  𝑡 =  
𝑟∗ √𝑁−2

1−𝑟2    

โดยปกตแิลว้ตวั predictors กจ็ะมคีวามสมัพนัธก์นัเอง  
ลองหาความสมัพนัธข์องตวัแปรทัง้หมดดว้ย 
ค าสัง่: Statistics > Summaries > Correlation matrix เลอืก Pairwise p-value 

 
Script & Output 
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6.  หา Regression Model (Explanatory variables ทุกตวั ยกเวน้ class ซึง่เป็น Response variable) 
ค าสัง่: Statistics > Fits models > Linear Regression  

 
Script & Output 
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ค าสัง่: Models > Stepwise model selection 

 
Script & Output 
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Regression Model ทีไ่ดค้อื 
class = -56.075 + 0.630*CASH + 1.460*CHMAX + 0.006*MMAX + 0.015*MMIN + 0.049*MYCT 

Model นี้มคีวามแม่นย าเท่าใด? Multuple R-squared = 0.8649? 
ลองทดสอบ Model ในส่วนอื่น 
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สรปุค าสัง่ R (version 3.1.2)  

การจดัการข้อมูล   
การอ่านขอ้มลูจากไฟล ์Excel 
การสรา้งตวัแปรตวัใหม ่

Data > Import data > from Excel 
Data > Manage variables in active data set > Compute new variable 

การเปลีย่นแปลงค่าตวัแปร Data > Manages variables in active data set > Recode variables 
การแปลงตวัแปร numeric ใหเ้ป็น factor 
และการใหช้ื่อค่าของตวัแปร (value label) 

Data > Manages variables in active data set > Convert 
numeric variables to factors 

การจดัเกบ็ไฟลข์อ้มลู R Data > Active data set > Save active data set  
การเปิดไฟลข์อ้มลู R  Data > Load data set 
สถิติส าหรบัตวัแปรเดียว 
ตวัแปรเชิงคณุลกัษณะ  
การแจกแจงความถี ่ Statistics > Summaries > Frequency distributions 
กราฟแท่งและกราฟพาย Graphs > Bar graph / Pie Chart  
ตวัแปรเชิงปริมาณ  
ค่าสถติเิบือ้งตน้ (N, Mean และ SD) 
กราฟฮสีโตแกรม 

Statistics > Summaries > Numerical summaries 
Graphs > Histogram 

การแจกแจงความน่าจะเป็นแบบต่าง ๆ เช่น 
การแจกแจงปกต ิ(Normal distribution) 
การหาค่าวกิฤต เมื่อก าหนดระดบันยัส าคญั 
การหาค่าพ ี(p-value) ของค่าสถติ ิ

Distributtion > Continuous distributions > Normal distribution > 
Plot normal distribution 
Normal quantiles 
Normal probabilities 

การทดสอบการแจกแจงปกต ิ Statistics > Summaries > Shapio-Wilk test for normality 
การทดสอบค่าเฉลีย่ Statistics > Mean > Single-Sample t-test 
สถิติส าหรบัสองตวัแปร 
การเปรยีบเทยีบค่าความแปรปรวน 2 ค่า 
การเปรยีบเทยีบค่าความแปรปรวน > 2 ค่า 

Statistics > Variances > Two-variances F-test 
Statistics > Variances >  Bartlett’s test / Levene’s test 

การเปรยีบเทยีบค่าเฉลีย่ 2 ค่า (Independent 
Samples) 

Statistics > Means > Independent samples t-tes 
Statistics > Nonparametric tests > Two-sample Wilcoxon test   

การเปรยีบเทยีบค่าเฉลีย่ 2 ค่า (Paired Samples) Statistics > Means > Paired t-test  
Statistics > Nonparametric tests > Paired-samples Wilcoxon test   

การเปรยีบเทยีบค่าเฉลีย่ 2 ค่าหรอืมากกว่า  
(Independent Samples) 

Statistics > Means > One-way ANOVA  
Statistics > Nonparametric tests > Kruskal-Wallis test 

การแจกแจงความถีส่องทางและการ
ทดสอบความเป็นอสิระของตวัแปร 2 ตวั 

Statistics > Contingency tables > Two-way tables  

การหากราฟความสมัพนัธข์อง 2 ตวัแปร Graphs > Scratterplot 
การหาความสมัพนัธข์อง 2 ตวัแปร Statistics > Summaries > Correlation test / Correlation matrix 
การวเิคราะหก์ารถดถอย Statistics > Fits models > Linear Regression 

                     Models > Stepwise model selection 
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การท าเหมืองข้อมูลด้วย Weka  
(Data Mining with Weka) 

สณีุ  รกัษาเกียรติศกัด์ิ 

การติดตัง้ Weka 

1. Download โปรแกรมที ่http://www.cs.waikato.ac.nz/ml/weka/downloading.html  
2. ดลัเบลิคลกิเพื่อตดิตัง้ 

ในทีน่ี้จะใช ้version 3.7.11 (Book version 3.6)  
ตดิตัง้ตาม default และ Next 

 
 
จนถงึ 

http://www.cs.waikato.ac.nz/ml/weka/downloading.html
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3. Install JRE  

 
 
กดปุ่ ม Install 
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4. ตดิตัง้เรยีบรอ้ย 
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การเรียกใช้ Weka 

1.  All Programs > Weka 3.7  

 
หรอื ส าเนา short cut Weka 3.7 มาไวบ้น desktop เพือ่สะดวกในการเรยีกใช้ 
ดบัเบลิคลกิ Weka ไอคอน         มาท างาน   จะเกดิ  

 
คลกิ Do not show this message again  แลว้คลกิ OK 
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Weka GUI Chooser 

 
 

มี Interface การท างาน  4  แบบ 

1. Explorer 
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2.  Experimenter 

 
3.  KnowledgeFlow 
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4. Simple CLI 
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Weka_Workshops 

สณีุ  รกัษาเกียรติศกัด์ิ 

WS#1: Numeric Prediction 

Data set: cpu (Weka_data จะมไีฟล ์format เป็น  .arff) 
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1. Preprocess > Open file  เลอืก cpu 

 
ได ้

 
 

2. แอททรบิวิตต์วัสุดทา้ยจะเป็นตวัแปร class หากตอ้งการใหต้วัแปรอื่นเป็นตวัแปร class ให ้Edit แลว้
คลกิขวาตวัแปรทีต่อ้งการ  เลอีก  Attribute as class ตวัแปรนัน้กจ็ะมาอยูเ่ป็นตวัสุดทา้ย และแสดงเป็น
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ตวัหนา 
หมายเหตุ จะใชว้่า แอททรบิวิต ์หรอื ตวัแปร กไ็ด ้

 
ถา้ตอ้งการไดไ้ฟลล์ง Excel ก ็ctrl+A (Select All) แลว้ไป paste ลงใน Excel แลว้เพิม่บรรทดัแรกเป็น
ชื่อตวัแปร 
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3. Weka จะสรปุค่า descriptive statistics ของแต่ละตวัแปรให ้พรอ้มแสดงกราฟ (histogram) หรอืคลกิ 
Visualize All เพื่อด ูhistogram ของตวัแปรทุกตวัพรอ้มกนั 

 
 

4. Visualize scatter plot (ตวัแปร 2 ตวั)  โดยคลกิทีแ่ทบ็ Visualize  

. 
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5. Fit linear regressiom model 
Classify > Choose Classifier = functions > Linear Regression  
Test options = Use training ser (default) 

  
กด Start จะไดผ้ลลพัธ ์ 
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6. การแปลผล 
6.1 Model: Class/PRP = -56.075 + 0.0491*MYCT + 0.0152*MMIN + 0.0056 *MMAX  

+ 0.6298*CACH + 1.4599*CHMAX  
ตวัแปรใดทีไ่มเ่ขา้ในโมเดล? 

 
6.2 Evaluation: Correlation coefficient R=0.93 or R2=0.8649 

ตวัแปร predictor 5 ตวั คอื MYCT, MMIN, MMAX, CACH, CHMAX สามารถอธบิายความ
แปรปรวนของตวัแปร Class/PRP ไดป้ระมาณ 81% 

 
6.3 Deployment: เครือ่งคอมพวิเตอรเ์ครือ่งใหม่ 1 เครือ่ง มคีุณสมบตัดิงันี้ MYCT=200, MMIN=1000, 

MMAX=2000, CASH=0, CHMAX=64 จะมปีระสทิธภิาพ (PRP) = 73.58 

คลกิขวาที ่Result แลว้ Save model 

 

7. ใหท้ดสอบทัง้ 3 test options จะไดว้่า Weka ใช ้ full training set ในการสรา้งโมเดล ซึง่ผลลพัธข์อง
โมเดลจะเหมอืนกนั  ซึง่สอดคลอ้งกบั Stepwise Regression ใน SPSS และใน R แต่ผลลพัธข์อง 
Evaluation จาก Correlation coefficient ของทัง้ 3 test mode คอื 1) Use training set, 2) Cross-
validation (10 folds), 3) Percentage split (66%) จะไมเ่ท่ากนั  
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WS#2: Classification by Logistic Regression 
Data set: diabetes 
1. Preprocess > Open file  เลอืก diabetes 

 
 
2. Edit เพื่อด ูtype และ ค่าของแต่ละตวัแปร 

 
ตวัแปร class (dependent/target) ม ีtype เป็น nominal ม ี2 ค่า คอื tested negative/tested positive 
ตวัแปร classifier (independent/predictor) ม ี8 ตวั ม ีtype เป็น numeric ทัง้หมด 
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3. ด ูdescriptive statistics ของแต่ละตวัแปรที ่Weka สรปุให ้พรอ้มแสดงกราฟ (histogram) หรอืคลกิ 
Visualize All เพื่อด ูhistogram ของตวัแปรทุกตวัพรอ้มกนั 

 
ขอ้มลูนี้มทีัง้หมด 768 ตวั (Instances/Cases/N) 
ตวัแปร 1 ถงึ 8 เป็นตวัแปร classifier ม ีtype เป็น numeric ดงันัน้ descriptive statistics จงึเป็น 
Minimum, Maximum, Mean, Standard Deviation (StdDev)  
ตวัแปร class จะเป็นตวัแปรสุดทา้ยเสมอ ม ีtype เป็น nominal 
ลองคลกิ Visualize All จะเหน็กราฟความสมัพนัธข์องตวัแปร class กบัตวัแปร classifier แต่ละตวั 

 
4. Visualize scatter plot (ตวัแปร 2 ตวั)  โดยคลกิทีแ่ทบ็ Visualize  
 
5. Fit logistic regressiom model 

เลอืกแทบ็ Classify > Choose Classifier = functions >Logistic (Regression) 
Default Test option = Cross validation Fold 10 
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กด Start จะไดผ้ลลพัธ ์ 
 

6. การแปลผล 
6.1 Model: Class = e-0.1232*preg + e-0.0352*plas + e0.0133*pres + e-0.0006*skin + e0.0012*insu +  

                     e-0.0897*mass + e-0.9452*pedi + e-0.0149*age + 8.4047 หรอื 
          Class = 0.8841*preg + 0.9654*plas + 1.0134*pres + 0.9994*skin + 1.0012*insu +  
                     0.9142*mass + 0.3886*pedi + 0.9852*age  
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6.2 Evaluation:  

 
6.3 Deployment: แทนค่าลงในสมการขอ้ 6.1 

คลกิขวาที ่Result แลว้ Save model 
  
7. ใหท้ดสอบทัง้ 2 test options (Use training set, Cross-validation Folds 10 จะไดว้่า Weka ใช ้ full 

training set ในการสรา้งโมเดล ซึง่ผลลพัธข์องโมเดลจะเหมอืนกนั แต่ accuracy จะไมเ่หมอืนกนั   
ในวธิกีาร Cross-validation Folds 10  Weka จะแบ่งขอ้มลูทัง้หมดออกเป็น 10 ส่วน และรนั 10 ครัง้ 
โดยครัง้ที ่1 ใช ้ส่วนที ่1 เป็น test set ส่วนทีเ่หลอืทัง้หมดอกี 9 ส่วนเป็น training set  
     ครัง้ที ่2 ใช ้ส่วนที ่2 เป็น test set ส่วนทีเ่หลอืทัง้หมดอกี 9 ส่วนเป็น training set  
จนถงึครัง้ที ่10 ใช ้ส่วนที ่10 เป็น test set ส่วนทีเ่หลอืทัง้หมดอกี 9 ส่วนเป็น training set 
โดย evaluation accuracy จะเป็นค่าเฉลีย่ของทัง้ 10 ครัง้  
จากนัน้จะรนัโมเดลอกีครัง้โดยใช้ full training set ทัง้หมดในการรนัโมเดล 
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WS#3: Classification by ML algorithm 

Data set: diabetes 
1. Preprocess > Open file  เลอืก diabetes 
2. Fit classification model Classifier = rules > ZeroR (baseline accuracy) 

การแปลผล 
Model: Class = tested_negative 

 
 Evaluation:  

 

 
Deployment:  tested negative  

3. Fit classification model Classifier = rules > OneR  
การแปลผล 

Model: ไม่ make sence 

 
 Evaluation: (cross-validation) 
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Deployment:  ใชก้ฎ (apply rule) 

4. Fit classification model Classifier = trees > J48  
หมายเหตุ  ตาม default parameter จะไดจ้ะได ้20 กฏ ซึง่บางกฏ กเ็ป็นจรงิส าหรบัขอ้มลูจ านวนน้อย 
ดงันัน้ควรจะปรบั parameter “minNumObj”  เช่นถ้าตอ้งการใหก้ฏเป็นจรงิส าหรบัขอ้มลู 10% กป็รบั 
minNumObj = 77  โดยคลกิที ่J48  แก ้minNumObj 
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การแปลผล 
Model: คลกิขวาที ่Result เลอืก Visualize tree 

  

 Evaluation: (cross-validation) 

 

 
Deployment:  คลกิขวาที ่Result แลว้ Save model 
 

7. ใหเ้ปรยีบเทยีบผลการทดลองดว้ย Classifier ตวัอื่น ๆ เช่น rules > PART, rules > JRIP  
(จะด าเนินการใน Experimenter Interface) 
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WS#4: Association Problem Type 

Data set: supermarket 
1. Preprocess > Open file  เลอืก supermarket 

Edit เพื่อดกูารจดัเกบ็ขอ้มลู 

 
แถวหนึ่ง ๆ คอืตะกรา้สนิคา้หนึ่ง ๆ  t (=true) มสีนิคา้ชนิดนัน้ 
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2. Fit Association model โดยเลอืกแทบ็ Associate 

 
 
เลอืก Associator algorithm เป็น 
Apriori 
คลกิที ่Apriori (รปูทางขวา)  
ปรบั parameter ทีส่ าคญั 3 ตวัคอื  
-lowerBoundMinSupport = 0.2 
-minMetric (min Confidence) = 0.9 
-numRules = 10 
ผลลพัธ:์ ไมพ่บกฏใด ๆ เลย 
ลองปรบั  
-minMetric (min Confidence) = 0.85 

 
การแปลผล 

Model:  

 

 Evaluation: Min Support และ Confidence 

Deployment: เอา กฏ ไปใช ้ 
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WS#5: Clustering 

Data set: iris 
1. Preprocess > Open file  เลอืก iris 

ในทีน่ี้ iris มตีวัแปร class แต่เราจะไมใ่ชใ้นการ clustering แต่จะใชใ้นการเปรยีบเทยีบกบัค่าจากโมเดล 
2. Fit Clustering model โดยเลอืกแทบ็ Cluster 

 

 

กด Ignore attributes 

 
เลอืก class แลว้กดปุ่ ม Select 
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คลกิ SimpleKMeans  
ปรบั numCluster = 3 

 
การแปลผล 

Model:  

 
 Evaluation:  

 
Deployment: คลกิขวาที ่Result แลว้ Save model 
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Witten: “Data mining is an experimental science” 
 

WS#6 จงเปรียบเทียบการวิเคราะหโ์จทย ์Classification โดยใช้หลาย algoithms 

 

Experiment 1 

Data set: iris 

Algoritms: trees > J48, rules > OneR, rules > ZeroR 

1.   Weka GUI Chooser  เลอืก Experimenter 
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2. คลกิ New  

 
3. ที ่Datasets คลกิ Add new  แลว้เปิดเลอืก iris 

ที ่Algorithms คลกิ Add new แลว้เลอืก Choose:  rules > ZeroR, rules > OneR, trees > J48 
(Add new 3 ครัง้ ตาม default) 
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4. ไปทีแ่ทบ็ Run คลกิ Start 

  
5. ไปทีแ่ทบ็ Analyze  คลกิ Experiment  
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6. คลกิ Perform test 

 
 

7.  การแปลผลจาก Witten 
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Experiment 2: 

Data set: iris, breast-cancer, glass, ionosphere, segment-challenge 

Algoritms: trees > J48, rules > OneR, rules > ZeroR 

1. ไปทีแ่ทบ็ Set up คลกิ New 

2. ที ่Datasets คลกิ Add new  แลว้เปิดเลอืก iris, breast-cancer, glass, ionosphere, segment-
challenge (Add new 5 ครัง้) 
ที ่Algorithms คลกิ Add new แลว้เลอืก Choose:  rules > ZeroR, rules > OneR, trees > J48 
(Add new 3 ครัง้ ตาม default) 

 
3.  ไปทีแ่ทบ็ Run คลกิ Start 

4. ไปทีแ่ทบ็ Analyze  คลกิ Experiment 
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5. คลกิ Perform test 

 
6. เปลีย่น Test base  Select เป็น rules.OneR 

 
 

 


